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INTRODUCTION
About this Manual

Infroduction

About this Manual

Release Notes

Installation on
Mac OS X

Welcome to this User Guide for Keylight on After Effects.

Keylight is an Academy award winning blue and green
screen keyer. The core algorithm was developed by the
Computer Film Company and has been further developed
and ported to After Effects by The Foundry.

We hope you enjoy using Keylight.

Use the Quick Key chapter to see how a simple key is
pulled using Keylight. The Basic Keying Chapter goes
over the most common parameters you’ll need to pull a
variety of keys. The Advanced Keying Chapter explains
how to tackle difficult keys.

For information on system requirements, new features,
improvements, fixed bugs and known bugs &
workarounds, see “Appendix A” on page 69.

To install Keylight on a Mac follow these instructions:
1. Double-click on the Keylight Installer - Keylight1.0v4.pkg

2. Follow the on screen instructions to install Keylight.

3. Quit.

The Foundry
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INTRODUCTION
Installation on Windows

Installation on
Windows

About The Foundry

Keylight can be found in the Effect - Keying menu.

To install Keylight on a PC follow these instructions:

1. Double-click on Setup.exe in the Keylight folder.

2. A window will appear welcoming you to the Keylight Setup. Click
Next to continue to the license agreement.

3. When the software license agreement appears, please read it. If you
agree, click Yes to continue the installation.

4. Choose the location to install Keylight on your hard disk. To accept
the default location, and it is strongly recommended that you do,
just click Next to continue.

5. The Keylight plug-in will be installed.
6. Click Finish to quit the installer.

Keylight can be found in the Effect - Keying menu.

The Foundry specialises in developing plug-in visual
effects for compositing platforms in the film and video
industry. Based in London's Soho, the Foundry has tailored
its image processing tools to the needs of post production.

Tinder plug-ins have been developed by the Foundry and
have been sold to hundreds of users throughout the world.
They are available on the leading compositing platforms
including flame*, flint*, inferno*, fire* and smoke* from
Discreet, AvidIDS and Adobe After Effects.

Furnace is a rich collection of image processing tools to
help compositors tackle common problems when working

Keylight
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INTRODUCTION
About CFC

About CFC

on films. Plug-ins include wire removal, retimer, rig
removal, texture plug-ins, grain tools, steadiness and
deflicker.

Anvil is a set of colour correction and colour manipulation
tools. It was originally developed by Paul Grace at First Art
and is now available on a variety of platforms.

Visit The Foundry’s web site at www.thefoundry.co.uk for
further details.

The Computer Film Company (CFC) pioneered the field of
digital film compositing and today operates a state of the
art film effects facility in London. The company has always
invested in research, and maintains the kind of edge that
has twice been honoured with Technical Achievement
Awards from the Academy of Motion Picture Arts and
Sciences.

Visit Framestore-CFC’s web site at www.framestore-
cfc.com for further details.

The Foundry
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GETTING STARTED
Infroduction

Getting Started

Intfroduction Keylight has been refined over a number of years to make
keying quicker and easier while providing a depth to the
tools that will tackle even the most challenging shots.

Keylight was first developed by The Computer Film

Company to help with difficult keys feature films. Over the
years Keylight has been refined in production on hundreds
of films. This pioneering work on digital compositing was

honoured with a Technical Academy Award® in 1996.

Notation When we refer to blue screens throughout the text we
mean, of course, blue or green screens.

Quick Key Keylight is available from the Effect - Keying menu in
After Effects.

Consider this shot from The Saint, pictures courtesy of

The Foundry Keylight



10 GETING STARTED
Quick Key

CFC and Paramount British Pictures Ltd. Figure 1 is the

Figure 1. Blue Screen.

blue screen foreground that should be composited over the
background shown in Figure 2.

Figure 2. Background.

If you want to have a go of this shot, you can! The images
can be downloaded from our web site and this quick key is
also covered in the Tutorial Chapter. See “Tutorial 1:
Simple Key” on page 47.

Throughout this user guide we assume a good
understanding of After Effects. To perform this quick key,
do the following:

Keylight The Foundry



GETTING STARTED 11
Quick Key

1.

Create a new composition using SaintFG.tif and SaintBG:.tif, layer
the clips with the blue screen over the background as shown in
Figure 3.

T Wt L

Figure 3. Screen Shot showing Saint blue screen.

The Foundry
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GETTING STARTED
Quick Key

2. Select the blue screen clip (SaintFG.tif) in the Time Layout window
and apply Keylight from the Keying sub-menu of the Effect menu.
See Figure 4.

Figure 4. Apply Keylight from the Effect - Keying menu.

3. The Keylight parameters are shown in Figure 5.

SawntfCrub « EMect Canirls

Figure 5. Keylight Parameters.

Keylight The Foundry



GETTING STARTED
Quick Key

4. Select the Screen Colour eye dropper and click on the blue screen
in the composition window. A good place to pick is the blue from

s

Figure 6. Pick the blue from the back windscreen.

the back windscreen as this has no reflections. Picking this blue will
key the back windscreen perfectly leaving reflections in the side
window. See Figure 6.

5. That’s it. In many cases this is all you will need to do to perform a
key, since selecting the screen colour creates a matte and despills
the foreground. The final composite is shown in Figure 7.

Figure 7. Final composite.

There are a couple of extra steps that can be taken to fine
tune this key and these are discussed in “Tutorial 2: Fine
Tuning a Key” on page 52.

Picking the screen colour may be enough for a lot of keys,
but there are many more tools within Keylight that can be

The Foundry
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Quick Key

used to tackle more complicated shots. These are described
in later chapters.

Keylight The Foundry



BASIC KEYING
Screen Colour

Basic Keying

Screen Colour

The following section describes the parameters you need to
do basic keying. This will give you enough to tackle most
simple keys. A discussion of advanced parameters to fine
tune keys and tackle complex keys can be found in the next
chapter.

The Screen Colour is probably the most important
parameter and you should always pick the screen colour
before doing anything else. It should be set to the colour of
the green or blue curtain behind the foreground object.
Select the eye dropper and pick the screen colour directly
from the composition window. Setting the Screen Colour
will create a matte - the Screen Matte - and despill the
foreground. In some cases this is enough to get a decent
key. For more information on Screen Colour see page 21.

Figure 8 shows a well lit blue screen behind an actor. You

=

Figure 8. Blue Screen.

should note that repeatedly picking the Screen Colour will

The Foundry
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BASIC KEYING

View
override any previous selections. It will not add to previous
selections and key more of the image with each click. To
key more of the image, if the foreground is showing
through the background, you need to use the Screen
Strength parameter.

View After picking the Screen Colour it’s useful to be able to

view the key in different ways. You can do this using the

866 SaintFG.rgb « Effect Controls 1
SaintFG.rgb o
Saint # SaintFG.rgb 5
ource
= 7 [T
Eifect Favorites Source Alpha
b Aboat Corrected Source
@ Controls Colour Correction Edges
: s v i Inside Matte
b &) Sereen Strength Ouls@e Matte
b & Screen Balance Combined Matte
b & Alpha Biaz Status
b &) Despill Bias Intermediate Result
2 | Final Result
I & Sereen Pre-biur
b Sereen Matte
b Inside Mask
+ Swurce A [ —
b Outside Mask
b+ Foreground Colour Correction
I+ Edge Colour Correction
b Source Crops
b Viewsr

Figure 9. View Menu.
View Menu, shown here in Figure 9. The options you’ll
use the most are:

Screen Matte - this renders the matte created by
picking the screen colour.

Status - this renders an exaggeratted view of the mattes
so that minor problems are shown clearly.

Keylight
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Status

Status

- Final Result - this renders the foreground composited
over the background using all mattes, spill and colour
corrections.

The Status is one of the options in the View menu and
shows an exaggerated view of the key so that you can
make a more informed decision when refining the
composite. Figure 11 shows the Status display after the

Figure 10. Green Screen. Figure 11. Status.

screen colour has been picked from the image shown in
Figure 10. Three colours are displayed. Black pixels show
areas that will be pure background in the final composite.
White pixels show areas that will be pure foreground. Mid-
grey pixels will be a blend of foreground and background
pixels in the final composite. You need grey pixels around
the edge of the foreground to get a good key at the
foreground edge. However, if there are grey pixels where
there should be pure background, you should try to remove
these with the Screen Strength, Clip Black or Outside
Mask. If you have grey pixels where there should be pure
foreground this tells you that parts of the background will

The Foundry
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BASIC KEYING
Screen Strength

Screen Strength

show through here and you will need to firm up the
foreground with Clip White or an Inside Mask.

Pixels that are a blend between the foreground and
background are shown in just one shade of grey. This is
done to highlight potential problems with the key. These
grey pixels may represent a foreground/background blend
of 50/50 or 99/1. No distinction is made as to this ratio.

You may occasionally see other colours in the Status View
and these are covered on page 31 in the Advanced Keying
Chapter.

The Screen Strength controls how much of the screen
colour is removed to make the screen matte. Increasing this

Figure 12. Status View after Figure 13. Status showing the
picking the Screen Colour. increase in Screen Strength.

value will key more. Figure 12 shows the Status View after
picking the Screen Colour. You can clearly see that parts of
the background are grey where they should be black. When
composited you may see faint pixels from the foreground
where you should be seeing pure background. Increasing

Keylight
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Despill Bias

Despill Bias

the Screen Strength will fix this, as shown in Figure 13, but
increasing it too much will destroy your good work. Like
many keying parameters it’s a balance - not too much, not
too little. Increasing the Screen Strength too much will lead
to the background showing through the foreground and
edge detail will be destroyed. Figure 15 on page 19 shows

i\l

Figure 14. Screen Strength = 105 Figure 15. Screen Strength = 150
giving a good Screen Matte. giving background show through
and over eroded edges.

this quite well. Note the steering wheel is black when it
should be white. If you look at the composite you will see
the background showing through here. Also, some of the
fine hair detail on the actor, visible in Figure 14, has been
eroded in Figure 15.

Although the foreground is despilled automatically, you
may find the need to pull out a little more of the screen
colour after picking from the image. You can do this with
the Despill Bias control. Just increase the parameter until
the blue disappears. However, if you increase too much the

The Foundry
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20 BASICKEYING
Despill Bias

foreground will become transparent. There are ways to fix

Figure 16. Exaggeratted blue spill.  Figure 17. Despill Bias used to
remove the blue spill.

that and these are covered in the next chapter. See “Alpha
Bias” on page 27.

Keylight The Foundry
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Advanced Keying

Screen Colour

Background Pixel

The following section describes the parameters you need to
fine tune keys and get the most out of Keylight. Basic
parameters covered in the previous chapter may also be
covered here in more detail.

The screen colour represents the colour of the pure blue (or
green) screen. The first thing you should do when pulling a
key is pick the Screen Colour. This single colour has a
primary component, blue or green, and that has a
saturation. Once the screen colour has been picked,
Keylight analyses all the pixels in the image and compares
the saturation of the primary component in each of these
pixels with the corresponding saturation of the screen
colour, setting the alpha and modifying the colour
accordingly.

If the saturation of the pixel in the image is as strong, or

-+

Saturation —p

Screen Colour Pixel Result

Figure 18. Blue screen pixel set alpha to zero.

The Foundry
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22 ADVANCED KEYING
Screen Colour

greater than the screen colour, then it’ll be a pixel from the
blue screen background, and that pixel will be set to
completely transparent and black. See Figure 18.

Edge Pixel If the saturation of the pixel is less than the screen colour,
then it’ll be the edge of the foreground object, and we
subtract some of the screen colour from the pixel (de
spilling) and set the image to semi-opaque. See Figure 19.

e
i HJ Ifl

Screen Colour Pixel Result

Saturation —p

Figure 19. Edge pixel gives partial alpha.

Foreground Pixel If the primary component in the pixel is not the same as the
primary component of the screen colour we have a

Keylight The Foundry



ADVANCED KEYING
Screen Balance

Note

Screen Balance

foreground pixel, and the alpha is set to completely

-+

Saturation —p

Screen Colour Pixel Result

Figure 20. Foreground pixel gives full alpha.

opaque. The pixel colour is not modified. See Figure 20.

You should note that the Screen Colour is a single colour. You are not
picking lots of colours that are keyed out.

Saturation is measured by comparing the intensity of the
primary component against a weighted average of the two
other components. This is where the Screen Balance
control comes in. A balance of 100% means that the
saturation will be measured against the smallest of the
other two components in the screen colour.

A balance of 0% means that the saturation will be
measured against the larger of the other two components. A
balance of 50% will measure the saturation from the
average of the other two components.

The appropriate balance point for each image sequence
you key will be different depending on the colours in that
image. Generally speaking, blue screens tend to work best

The Foundry
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ADVANCED KEYING

Despill Bias
with a balance of around 95% and green screens with a
balance of around 50%. If the key is not working too well
with these settings, try setting the balance to about 5%,
50% and 95% and see what works best.

Despill Bias In situations where the key is removing too much screen

Negative Bias

colour from the image or not enough, the Despill Bias can
be used to adjust the key. Roughly speaking, you should
use a negative bias when there is too much of the screen
colour being removed and a positive one when there is not
enough.

Consider the image shown in Figure 21. This shot, from the

Figure 21. Is this the worst green screen you’ve ever seen?

film Executive Decision, is actually a green screen
although it doesn’t look it. The colour of the screen in the
background is around 28% red, 25% green and 8% blue.
This is in fact red, but only just. Note that the pilot in the
cockpit is predominantly brown, at around 42% red, 25%

Keylight
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ADVANCED KEYING
Despill Bias

green, 15% blue. So a default key from that screen colour

would make the foreground transparent (Figure 22) as it is
a more saturated red than the red of the screen colour. This
is not good.

Figure 22. Default key showing the transparency of the
foreground.

In this situation, the Despill Bias can help. By decreasing
this value slightly (negative bias), you scale down the red

Figure 23. Result of dropping the Despill Bias to -17.

component in the screen colour and the image. This flips
the screen colour of the shot from red to green, which

The Foundry Keylight
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ADVANCED KEYING
Despill Bias

Positive Bias

leaves the pilot predominantly red. Figure 23 on page 25
shows the new composite. Keylight has now keyed this
image correctly. We have effectively instructed Keylight to
see “less red” in both the screen colour and the foreground.

Despill Bias also helps when keying images that don’t have
enough of the screen colour removed. Consider Figure 24
from the film Merlin. Pulling a default key from this will

Figure 24. Original blue screen. Figure 25. Default key.
give the blue/purple fringing around the edges of her hair
as shown in Figure 25.

If we increase the Despill Bias (positive bias), the image
and the screen colour will have the blue component scaled
up before the key is pulled, effectively saying “No, it’s
bluer than you thought, pull more out”. This improves the
blue spill as shown in Figure 27 on page 27, but can make

Keylight
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ADVANCED KEYING
Alpha Bias

the foreground transparent as shown in Figure 29. This can

Figure 26. Default Key. Figure 27. With Despill Bias to
remove blue spill.

be fixed with a soft eroded inside mask and a replace

colour set to light brown to match the skin tones. However,

there is another way using the Alpha Bias.

Figure 28. Screen Matte with Figure 29. Screen Matte after
Despill Bias zero. increasing Despill Bias.
Alpha Bias Keylight does two things when making a key. It makes

sections corresponding to the screen colour transparent and
it removes that colour from the foreground. Sometimes it
can get one right, but the other wrong, and this often

The Foundry Keylight
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28 ADVANCED KEYING
Alpha Bias

happens when you use just the Despill Bias control as
shown above.

One way around this is to un-couple the Despill and Alpha
Bias controls so that the alpha is calculated using the Alpha
Bias and the despill is calculated using the Despill Bias.
Therefore, in the previous example, we should set the
Alpha Bias to zero to get a good solid alpha (Figure 31),
and set the Despill Bias to around 27 to remove the blue
spill. (Figure 30).

P/‘ .

Figure 30. Despill Bias 27 to  Figure 31. Alpha Bias 0 to improve
remove blue spill. the Screen Matte.

il

Keylight The Foundry
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View

View

After picking the Screen Colour it’s useful to be able to
view the key in different ways. You can do this using the

866 SaintFG.rgb « Effect Controls 1

() SaintFG.rgb %
Saint # SaintFG.rgb
- f
Effect Favorites
b Aboat
= Centroly
* View

= &) Sereen Colour
b & Screen Strength
b &) Screen Balance
b &) Alpha Bias

b & Despill Bias

[ &) Sereen Pre-biur
b Sereen Matte
b Inside Mask
* Seurce Apha
b Outside Mask
b+ Foreground Colour Correction
I+ Edge Colour Correction
b Source Crops
b Viewsr

Source O
| Source Alpha
Corrected Source
Colour Correction Edges
| Inside Matte
| Outside Matte
Combined Matte
Status
Intermediate Result

| Final Result

[T —

Figure 32. View Menu.

View Menu, shown here in Figure 32. Here’s the complete
list of options and what they do.

Source - displays the blue or green screen.

Source Alpha - displays the alpha channel embedded in

the blue or green screen.

Corrected Source - displays the uncomposited source
image with any colour corrections applied.

- Colour Correction Edges - displays the foreground
edges as a matte that will be colour corrected using the
controls in the Edge Colour Correction folder.

Screen Matte - displays the matte created as a result of

picking the screen colour.

The Foundry
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ADVANCED KEYING
Status View

Status View

Inside Mask - displays the mask that firms up the
foreground.

Outside Mask - displays the mask that cleans up the
background.

Combined Matte - displays all the screen matte, inside
and outside masks and any source alpha added together.
The combined matte is used to composite the
foreground over the background layer.

Status - displays an exaggerated view of the key so you
can make a more informed decision on how to improve
the result. See ““Status View” on page 30.

Intermediate Result - is used for multipass keying. The
alpha is set as per normal, but the RGB values are not
modified from the original.

Final Result - renders the foreground composited over
the image on the background track. This image is
premultiplied. In other words, the RGB values of pixels
have been multiplied by their corresponding alpha
channel values.

The Status View is one of the options in the View menu
and shows an exaggerated view of the key so that you can
make a more informed decision when fine tuning the

Keylight
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Status View

composite. Figure 34 shows the Status after the screen

Figure 33. Green Screen. Figure 34. Status.

colour has been picked from the image shown in Figure 33
on page 31. Three colours are displayed. Black pixels
represent pure background in the final composite. White
pixels are pure foreground and grey pixels are a blend of
the foreground and background pixels. The grey is just one
colour to highlight any areas that are not pure foreground
or background. Grey pixels do not mean the key is poor -
the final composite may be fine.

You may occasionally see other colours in the Status View.

Figure 35. Status showing Figure 36. Result showing Screen
processing of the Screen Matte. Matte Replace Colour.

Figure 35 shows black, white, grey and green pixels. The

The Foundry Keylight

31



32

ADVANCED KEYING
Status View

green pixels are a warning. They show you the parts of the
Screen Matte that have changed through processing the
matte (clipped, softened or eroded). These areas have had
the correct amount of spill removed, but the alpha has
subsequently changed and the composite may no longer
look right. This can be corrected using the Replace Colour
to put back colour in these areas. Figure 36 on page 31 is
an extreme example to illustrate the point. The Replace
Colour has been set to pure red and you can see that this
mirrors the green pixels in the Status View.

Similarly you may see blue pixels in the Status. These

Figure 37. Status showing how the Figure 38. Final Result showing
Inside Mask will affect the the Inside Mask Replace Colour.
foreground.

represent processed pixels in the Inside Mask that affect
the despill of the foreground. The Replace Colour in the
Inside Mask folder will be used to modify these pixels.
Another extreme example is shown in Figure 38. The
Replace Colour is set to pure yellow and the Replace
Method is Hard Colour.

You may also see dark red pixels which indicate areas
where an outside mask has been used to reduce the

Keylight
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Screen Matte

Screen Matte

Clip Levels

transparency of the image.

The Screen Matte (Figure 40) is the result of pulling the
blue or the green from the image (Figure 39) and making
those regions transparent. Once you have done this you

Figure 39. Green screen. Figure 40. Screen Matte.

will want to firm up the foreground (make it more white)
and clean up the background (make it more black). This
can be done by processing the Screen Matte.

The clip levels are adjusted using two parameters - Clip
Black and Clip White. Any alpha value at or below Clip
Black will be set to zero and any alpha value at or above

The Foundry
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Clip Rollback

Clip Rollback

Note

Clip White will be set to 100. Figure 41 shows the original

Figure 41. Clip Black = 0. Figure 42. Clip Black = 50.

alpha of an image and Figure 42 on page 34 shows the
result of clipping it. Notice how the grey areas in the black
background have been reduced and that the grey edges
have hardened up considerably. When compositing, the
Clip Black control can be used to improve the background
image if parts of the foreground are showing through. The
Clip White control on the other hand can be used to firm up
the centre of the matte, making it less transparent to the
background.

You need to be really careful if you chose to use Clip Black and Clip
White that you don't destroy the edges on your foreground. It is
possible to use Clip Rollback to compensate for this.

Pulling a Screen Matte (Figure 43) will typically produce
lots of transparency (grey) in the matte at the edges. This is
good since this is what you need to key hair well. You may
also get transparency in the foreground as shown in
Figure 44. This is bad as your subject will appear slightly

Keylight
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Clip Rollback

see-through, and this should be corrected. You can do this

"

Figure 43. Screen matte Figure 44. Close up screen matte
highlighting the close up view as showing unwanted (grey)
shown in Figure 44. transparency in the (white)
foreground.

with an inside mask shape, or you can use the Clip White
parameter to turn these grey pixels white. This cleans up
the foreground (Figure 45) but it will also destroy the edge
detail you want to keep. This is where Clip Rollback comes
in. This is used to put back the edges to restore the detail
that was lost. A rather exaggerated clip rollback is shown
in Figure 46 to illustrate the point.

A

Figure 45. Clip White has been  Figure 46. Clip Rollback has been
used to remove the unwanted grey  used to reduce the unwanted
pixels in the white matte. erosion of the edge.

The Foundry
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Grow & Shrink

Grow & Shrink

Despot

This control should not normally be used as eroding the
edges can produce a very poor key. However, this
parameter allows you to grow (if greater than zero) or
shrink (if less than zero) the alpha in the Screen Matte.

These controls are sub-pixel accurate.
. :
a. ; .
Fab X N

i\ aff)n

Figure 47. Screen Matte. Figure 48. Eroded Matte.

This controls how much to simplify the matte. It coagulates
similar regions so that, for example, black specks in the
white matte can be absorbed by the surrounding white
areas. Increasing the Screen Despot Black will remove
isolated spots of black in the white matte. Increasing

Keylight
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Colour Replacement

Colour
Replacement

Screen Despot White will remove isolated spots of white in
the background up to that size.

\1ff\

Figure 49. Eroded matte. Figure 50. Despot.

Remember that Keylight does two things - it removes the
screen colour to despill the image and generates an alpha
(Screen Matte) to composite the foreground over the
background layer.

If you then process the Screen Matte, for example, by
eroding the matte or changing the clip levels, Keylight will
be removing the wrong amount of screen colour from the
pixels whose transparency have now changed. The
Replace Method instructs Keylight how to deal with such
pixels. The Status will display which pixels use a replace
method. Those pixels who use a replace method because
the Screen Matte processing tools modified the
transparency will be green, whilst those pixels whose
transparency was modified by the inside mask will be blue.
See the Status View on page 31.

There are four options to the replace method, these are:

The Foundry
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Inside & Outside Masks

Inside & Outside
Masks

. None - the despilled image is left untouched if the alpha is modi-

fied.

. Source - the image will have a corresponding amount of the

original pixel (screen colour and all) reintroduced/removed if the
alpha is changed.

. Hard Colour - the despilled image has a corresponding amount of

the replace colour added for any increase in alpha.

. Soft Colour - the despilled image has a corresponding amount of

the replace colour added for any increase in alpha, however, it
attempts to modulate the luminance of the resulting pixel so that it
matches the original pixel. This will give a more subtle result than
the Hard Colour option.

If you can’t adequately improve the Screen Matte using the
Clip Levels, you can draw a spline mask round the pixels
you definitely want to be foreground or background. The
Inside Mask makes the foreground less transparent and the
Outside Mask is used to clean up the background that
might have bits of the foreground showing through. The
outside mask is often used to clean up screens that are not a
constant colour or have lighting rigs in shot (Figure 51) by

Keylight
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Inside & Outside Masks

forcing the alpha transparent. The inside mask can be used

Figure 51. Green Screen with
lighting rig visible.

to keep elements in the foreground that you don't want to
lose (an actor’s blue eyes in front of a blue screen). These
masks should normally be softened to blend into the
Screen Matte.

Figure 52 on page 39 shows an After Effects’s Mask
drawn around the lighting rig on the left side of the screen.
When this is used as the Outside Mask and the View
control set to render the Outside Mask, you will see the
image displayed in Figure 53. The outside mask forces that

Figure 52. AE Mask drawn round  Figure 53. AE Mask used as an
the lighting rig. Outside Mask and Viewed.

The Foundry Keylight
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Source Alpha

Source Alpha

part of the image to be in the background thus keying out
the rig. The Screen Matte shown in Figure 54 shows the

Figure 54. Screen Matte. Figure 55. Combined Matte.

matte pulled when the green screen is picked. When the
Outside Mask is subtracted from the Screen Matte we get
the Combined Matte, shown in Figure 55. Here you can see
the change in the matte that will result in the lighting rig
being keyed out in the final composite. If more than one
mask is required to remove garbage, then use the masks to
create an embedded alpha channel in the image and set the
Source Alpha to Normal. See “Source Alpha” on page 40.

This parameter determines how to deal with any embedded
alpha in the original image.
Ignore - this will not use any embedded alpha in the
key.
Add to Inside Mask - the embedded alpha is added to
the inside mask.

Normal - the embedded alpha is used to key the layer as
normal. It is added to Keylight’s screen matte and can

Keylight
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Colour Correction

Colour Suppression

be useful if requiring complicated multi-shaped masks
to rotoscope out garbage.

The Colour Correction parameters allow you to modify the
foreground colours in your composite. In particular,
reflected blues and greens from the screen can be
suppressed.

Saturation - this control will increase or decrease the
colour saturation of the image, making colours more or less
intense.

Contrast - the contrast is the ratio of brightest tones to the
darkest. Increase this value for a contrasty image and
decrease it to wash it out.

Brightness - the brightness equates to the overall
luminance of the image. Increase this value to make the
image lighter and decrease this value to make it darker.

Suppress - this controls colour suppression in the image.
You can choose to remove a specific primary, either Red,
Green, Blue or their complements, Cyan, Magenta or
Yellow. For green screens you may find it helpful to
suppress green.

Suppression Balance - determines what to reduce the
suppressed component to. If set to 0%, it will be the
smallest of the other two components, if set to 100% it will
be the largest of the other two components. Otherwise, it

The Foundry
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Edge Correction

Colour Balancing

Edge Correction

will be to a balanced average.

Suppression Amount - determines how strongly you want
to reduce the indicated component.

These controls are used to alter the colour balance of the
image. Choose a hue and saturation (either via the sliders
or the colour balance wheel) to shift the entire colour
balance of the image.

The Edge Correction parameters allow you to colour
correct edges to seat the composite into the background. To
see the areas considered an edge that you will be affecting,
select the Colour Correction Edges from the View menu.

Enable Edge Colour Correction - use this option to
separately colour correct edges of the image independently
from the overall colour correction.

Edge Hardness - this determines how strongly to blend
between the edge correction and the main correction.

Edge Softness - this will soften the region considered to be
the edge by this amount (in pixels).

Edge Grow - this will grow the region considered to be the
edge by this amount (in pixels).

Saturation - these controls determine how much to scale
the saturation of the image.

Keylight
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Edge Colour
Suppression

Colour Balancing

Crops

Contrast - this control increases/decreases the contrast on
the region considered to be the edge.

Brightness - this control brightens the region considered to
be the edge.

Controls the colour suppression in the image.

Suppress - Choose to completely remove a specific
primary, either Red, Yellow, Green, Blue or their
components, Cyan, Magenta or Yellow.

Suppression Balance - determines what to reduce the
suppressed component to. If set to 0%, it will be the
smallest of the other two components, if set to 100% it will
be the largest of the other two components. Otherwise, it
will be to a balanced average.

Suppression Amount - determines how strongly you want
to reduce the indicated component.

These controls are used to alter the colour balance of the
image edges. Choose a hue and saturation (either via the
sliders or the colour balance wheel) to shift the entire
colour balance of the image.

The Source Crops enable you to quickly cut out lighting
rigs or other unwanted elements using vertical and
horizontal lines.

The Foundry
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Crops

Note

Keylight requires access to source pixels that lie off the
edge of the source image. The cropping controls provide
access to all the controls required for specifying how pixels
are treated at these edges and where they appear. The built-
in crop controls are also useful for removing unwanted
black pixels at the edge of video footage.

XY Method - determines the behaviour of the image at the
left and right crop boundaries. Four edge methods are
supplied:

Colour - fills the area between the crop line and the
edge with the Crop Colour.

Reflect - reflects pixels about the current crop line. In
other words, it copies pixels from the other side of the
current crop line into the area between the current crop
line and the screen edge.

Repeat - copies pixels on the crop boundary to the
screen edge.

Wrap - copies pixels from the area between the
opposite crop line and its screen edge to the area
between the current crop line and its screen edge.

Horizontal and vertical crop boundaries can have different edge
methods, Cropping is often used to remove unwanted pixels at the edge
of an image. If a video clip is digitized badly you may get black edges
left and right. These can be easily removed by moving the vertical
crops and setting the edge method to Reflect.

Edge Colour - sets the fill colour used when the edge
method is set to Colour.

Edge Colour Alpha - sets the fill colour transparency.

Keylight
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Note

Left, Right, Top, Bottom - use these controls to set the
crop positions. Lines will be overlaid in the display
enabling you to set the various positions by eye.

The position of the crop lines can be changed by clicking and dragging
them directly on the screen.

The Foundry
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Infroduction

Tutorial

Intfroduction

Example Images

Tutorial 1: Simple
Key

We have included four tutorials with example images that
you can use to practice Keylight.

- Tutorial 1: Simple Key

- Tutorial 2: Fine Tuning a Key

- Tutorial 3: Extreme Blue Spill

- Tutorial 4: A Red Green Screen

- Tutorial 5: Inside & Outside Masks

The tutorial images referred to in this chapter can be
downloaded from our web site www.thefoundry.co.uk

From the home page click on the Downloads link then
After Effects and scroll down for the tutorial images.

Using the blue screen clip from The Saint, you will
composite the actor over the background. You will learn
how to:

Apply Keylight to a layer.
Pick the Screen Colour.
View the Final Result.

The clips you will need for this task are called SaintFG.tif
and SaintBG.tif, pictures courtesy of CFC and Paramount

The Foundry
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British Pictures Ltd for the film The Saint. You should
import them into After Effects and create a new
composition containing the blue screen of Elizabeth Shue
layered over the road.

Figure 56. Blue Screen - saint.tif

Figure 56 is the blue screen foreground that should be

Figure 57. Background - road.tif

composited over the background shown in Figure 57.

Keylight The Foundry
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1. Create a new composition using SaintFG.tif and SaintBG.tif, layer
the clips with the blue screen over the background as shown in
Figure 58.

T Wt L

Figure 58. Screen Shot showing Saint blue screen.

The Foundry
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Tutorial 1: Simple Key

2. Select the blue screen clip (SaintFG.tif) in the Time Layout window
and apply Keylight from the Effect - Keying menu. See Figure 59.

Figure 59. Apply Keylight from the Effect - Keying menu.

3. The Keylight parameters are shown in Figure 60.

SawntfCrub « EMect Canirls

Figure 60. Keylight Parameters
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4. Select the Screen Colour eye dropper and click on the blue screen
in the composition window. A good place to pick is the blue from

>

Figure 61. Pick the blue from the back windscreen.
the back windscreen as this has no reflections. See Figure 61.
5. That’s it. In many cases this is all you will need to do to perform a

key, since selecting the screen colour creates a matte and despills
the foreground. The final composite is shown in Figure 62.

Figure 62. Final composite

There are a couple of extra steps that can be taken to fine
tune this key and these are discussed in the next tutorial on
page 52.

The Foundry Keylight
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Tutorial 2: Fine Tuning a Key

Tutorial 2: Fine
Tuning a Key

Note

Using the images from the film The Saint, you will learn
how to fine tune the key pulled in Tutorial 1. You will
learn how to:

Use Status to judge the quality of the key.
Use the Screen Strength to improve the background.
Use the Despill Bias to remove more blue spill.

1. Create a new composition using SaintFG.tif and SaintBG.tif. Apply
Keylight to the blue screen layer. Select the Screen Colour eye
dropper and click on the blue screen in the composition window.

These steps were covered in greater detail in the previous chapter.

2. Before we do anything else we need to look at the quality of the key
so far. On first inspection, the composite looks pretty good, but it’s
hard to judge. To see any potential problems more clearly, switch to
the Status view as shown in Figure 63. Here we can see that the

4 —

Figure 63. Status showing grey pixels in the background.

windscreens are a mixture of black and grey pixels. The black
pixels tell us that pure background will be seen here in the final
composite. The grey pixels tell us that there will be a mix of
foreground and background pixels. What we want is a clean
background showing through the windows, but with some
reflections in the side window preserved. In other words we need
mostly black pixels with a few grey ones.

Keylight
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3. Figure 64 on page 53 shows the Status view that we’re aiming for.
The background has been cleaned up and we still have some
reflections in the side window. To get this you should increase the
Screen Strength from 100 to 106.

s ;- T : ——

Figure 64. Improved background with Screen Strength.

4. Finally, if you look closely at the composite you will see a tiny
amout of blue spill on the woman’s hand and in her hair. This was
from reflected light from the blue screen. By increasing the Despill
Bias to 18 we can remove it. Use the Comparison Buffer to see the
difference.

S
Figure 65. Final Composite
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Tutorial 3: Exireme  This is a really interesting clip from the film Merlin. The

Blue Spill results with Keylight are certainly not perfect, indeed it is
unlikely that you will ever end up with a truly realistic
looking shot. However, there are some interesting things to
observe. You will learn how to:

Reduce the blue spill using Screen Balance and Despill
Bias.

Improve the foreground opacity using Alpha Bias.

1. Load the MerlinBlueFG.tif (Figure 66) and MerlinBlueBG.tif clips
and apply Keylight.

Figure 66. A tricky blue screen.

2. Pick the Screen Colour using the eye dropper.

Figure 67. Serious blue spill.
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Pick a pure blue pixel away from the hair.

. Increase the Screen Strength from 100 to 105. This will clean up a
little of the background.

. Alter the Screen Balance from 50 to 0 as shown in Figure 68. This
step is a bit subjective, but improves the blue spill.

Figure 68. Adjust the Screen
Balance

. Now let’s try and get rid of that blue spill. Increase the Despill Bias
to 40. When you do this the image and the screen colour will have
the blue component scaled up before the key is pulled so that more
blue is removed. You will have noticed that the foreground has gone
quite transparent. This can be compensated for by dropping the
Alpha Bias. Un check the gang button and try setting it to 30.

Figure 69. Despill and Alpha Bias.

The Foundry
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Tutorial 3: Extreme Blue Spill

. You will notice that Miranda Richardson’s face now has a number

of highlights, due to the transparency, that we should fix. The best
way to do this is by drawing a spline round the face (Figure 70)

Figure 70.

and using it as an Inside Mask. Refer to your After Effects guide for
more information on masks, however, select the pen tool, draw a

bezier spline around the face on frame 1 (Mask 1), switch this mask
off (Figure 71) then in Keylight set the Inside Mask to Mask 1 and

Source to None. You should also soften the mask slightly by setting

100 (25.00 fps) [2[=[M]
D@ %] * | source Name | rode T Trktst || Parent
T v0O 1 G fol0001-0zs0lrgy =T I ) —

< Masks | None |
b O Mask 1 Vv Add k.
i ‘:::::Iw Subtract
b Transform Intersect
Tp0 2 HONONENESEN  Lighten
Darken
Difference
e

[0

Switches / Modes

Figure 71. Switch the Mask off.

the Inside Mask Softness to 5.

Keylight

The Foundry



TUTORIAL  §7
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7. View Final Result as shown in Figure 72.

Figure 72.

The Foundry Keylight
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Tutorial 4: A Red Green Screen

Tutorial 4: A Red Using the images from the film Executive Decision, you
Green Screen will learn how to pull a key from a poor green screen using
the Despill Bias control. You will learn how to:

Pick the Screen Colour.
Drop the Screen Bias.
Produce a final composite.

The images you will need for this tutorial are called
ExecFG.

1. Load the pictures ExecFG.tif (Figure 73) and ExecBG.tif. Apply
Keylight. The foreground image is actually a green screen shot

Figure 73. Poor Green Screen.

although it doesn’t look it. If you analyse the pixels it’s slightly
more red than green. To key this we’ll have to fool Keylight.

2. Pick the Screen Colour. You should go for the slightly darker green
patch to the left of the pilot. Although feel free to experiment

Keylight The Foundry
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Tutorial 4: A Red Green Screen

picking different parts of the green screen. The initial selection
gives the result shown in Figure 74.

Figure 74. Default key.

3. To fix this we need to tell Keylight to scale down the red component
to make the green the most dominant so that it keys correctly. To do
this decrease the Despill Bias to -20. The result is shown in
Figure 75.

Figure 75. Decrease the Despill Bias.

The Foundry Keylight
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4. If you look closely, the background and foreground needs cleaning
up. Figure 76 shows the Status View. We will use the Screen Matte

o

Figure 76. Status View.

tools to make the cockpit windows black and the pilot white.

5. Increase Clip Black to 20 to remove some of the foreground
showing through the background. Decrease Clip White to 70 to
improve the opacity of the foreground. Increase Screen Softness to
1, Screen Despot Black to 2 and Screen Despot White to 2.

Figure 77. Composite.
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6. Use the Screen Matte Replace Method to pull some of the original
image through the composite. This improves the apparant
graininess in the foreground. Figure 78 shows the differences.

Figure 78. Close up view. The left image has Replace Method
set to Source. The right image has Replace Method set to None.

The Foundry
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Tutorial 5: Inside &
Outside Masks

Using the 16 bit blue screen test card image you will learn
how to:

Use Inside and Outside Masks.
Use the Replace Method to put back keyed out colours.
Process the Screen Matte.

The clips you will need for this task are called TestCard.cin
and ColourGrid.cin

1. Start After Effects. Create a new 16 bit project. Load the pictures
TestCard.cin (Figure 79) and ColourGrid.cin and put them into the

Figure 79. Test Card.

composition layering the blue screen over the colour grid.

Keylight
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2. Apply Keylight to the blue screen layer and pick the blue from the
image. Keylight will create a matte and despill the foreground as

Figure 80. Basic Key.

shown in Figure 80.

3. To remove the garbage around the subject we will use an outside
mask. Using AE’s masks, draw a spline around the person and test
cards. This will be called Mask 1 by default. This is shown as the
yellow line in Figure 81. In the Time Layout window twirl open the

I T P = 1

Figure 81. Outside Mask.

TestCard layer and Masks sub-layer and set the compositing mode
from Add to None.

The Foundry Keylight
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4. InKeylight, set the Outside Mask to Mask 1 and switch Invert on or

TS

Figure 82.

you’ll be removing the person rather than the unwanted pixels at the
screen edges.

5. You will have noticed in Figure 82 the "dirt" around the subject’s

Figure 83.
head. Clealy we have to improve the key. You can also see the the
faults in the matte if you view the Status as shown in Figure 83.
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6. Increase the Screen Strength to 110. This cleans up some of the
background as shown in Figure 84.

Figure 84. Increase Screen
Strength.

7. Sections 7 to 10 will cover the changes to the Screen Matte that will
improve the key. In the Screen Matte parameter area, decrease the
Clip White from 100 to 70. This will improve the foreground as

Figure 85. Clip White.

shown in Figure 85. However, you will notice in the composite that
the edges have become a little hard. We can fix this using the Clip
Rollback and Screen Softness.

The Foundry Keylight
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8. Increase the Clip Rollback to 3 and the Screen Softness to 1. It’s

Figure 86.

also worth trying to improve the key around the spikey flowers with
a sub-pixel erode of the edge. Change Screen Grow/Shrink to -0.5.

9. To remove the foreground spots increase Screen Despot Black to 1.

Figure 87. Screen Despot Black.

The result is shown in Figure 87.
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10. The composite is shown in Figure 88. You will see that the colours
of the colour swatches have been altered by the Keylight algorithm.
This can be fixed with an inside mask.

Figure 88. Composite.

11. Draw a rough mask (Mask 2) around just the colour swatches. Set

Figure 89. Inside Mask and
Replace Method Source.

the Inside Mask to Mask 2 and the Replace Method to Source to
pull back the original colours.

12. That’s it.

The Foundry Keylight
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Release Notes

Keylight 1.0v4

This appendix describes the requirements, new features,
improvements over previous versions, fixed bugs and
known bugs and workarounds in Keylight.

This is a maintenence release to fix a bug.

Requirements

Adobe After Effects 6.0 or 6.5 Professional on Mac OS X
or PC.

Release Date
8 September 2003

New Features
There are no new features.

Improvements

1. Installer for Mac OS X changed to standard pkg format. Plug-ins
remain the same.

Fixed Bugs

1. BUG 354. On PC only, on selecting Edit>Purge>All After Effects
will crash. This has been fixed in this release.

Known Bugs and Workarounds
There are no known bugs.

The Foundry
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Keylight 1.0v3

Keylight 1.0v2

This version is the full release and is supplied on the Adobe
After Effects 6.0 Professional CD.

Requirements
Adobe After Effects 6.0 Professional on Mac OS X or PC.

New Features
There are no new features.

Improvements
There are no new features.

Fixed Bugs

1. During a Keylight render, if a redraw of the After Effects user inter-
face occurs, possibly due to a screen saver or window stowing, this
may cause Keylight to crash. This bug has been fixed.

2. BUG 346. If Keylight was copied and pasted between
compositions, After Effects will crash. This has been fixed.

Known Bugs and Workarounds
There are no known bugs.

Requirements
Adobe After Effects 6.0 Professional on Mac OS X or PC.

New Features
There are no new features.

Improvements

Keylight
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Keylight 1.0v1

1. A new parameter, "Normal", has been added to he Source Alpha
menu to allow embedded alpha to key the layer as normal. This
allows multi-shape masks to be used as garbage mattes.

Fixed Bugs
There are no fixed bugs.

Known Bugs and Workarounds
There are no known bugs.

Requirements
Adobe After Effects 6.0 Professional on Mac OS X or PC.

New Features
This section will describe new features in later versions.

Improvements
This section will describe improvements to existing
features in later versions.

Fixed Bugs
This section will describe fixed bugs in later versions.

Known Bugs and Workarounds
There are no known bugs.
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Appendix B

End User License Agreement

The copyright in this Keylight software ("the Software") and its associated
documentation is owned by Framestore-CFC, the copyright in the various support
modules, including image management, processing, bluring, user interface and licensing
is owned by The Foundry Visionmongers Ltd, trading as The Foundry, ("the Owners").
The Software is distributed by The Foundry ("the Agent").

This is a legally binding agreement between you and the Owners which will govern your
use of the Software, you agree with the Owners to be bound by all of its terms and
conditions. Please read this document carefully before opening this package and using
the Software. If you do not accept these terms you may within 14 days of purchase return
the Software, its packaging and documentation unused and intact to your supplier
together with proof of purchase for a full refund of any license fee you may have paid for
this software.

License

The Owners hereby grant to you a personal, non-transferable (except as expressly
provided in clause 2 below) and non-exclusive right to use this software on a temporary
trial basis if no license fee has been paid. If a license fee has been paid, you may continue
to use this software under these same conditions. Your rights are to:

- load and install the Software by copying it onto the hard disk drive or into the CPU
memory of a single computer which is under your control for use thereon; and

- make up to 3 full or partial copies of the Software, but only as necessary for backup or
archival purposes, provided that:

The Foundry Keylight
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- your use and possession of such copies shall be solely under the terms and
conditions of this agreement, and

-you shall place the same proprietary and copyright notices on all such copies
as are included by the Owners on the medium containing the authorised
original copy of the Software.

You may not under any circumstances:

store, use or allow the use of the Software in any manner on more than one computer
at any time;

save to the extent and in the circumstances expressly required to be permitted by law,
copy, modify, adapt, merge, translate, reverse engineer, de compile, disassemble or
create derivative works, based on the whole or any part of, the Software;

except as expressly provided in clause 2 below, distribute, lease, rent, sub-license,
transfer, assign, loan or otherwise convey the Software or any portion thereof to
anyone.

To the extent that local law gives you the right to de compile the Software in order to
obtain information necessary to render the Software interoperable with other computer
programs, the Owners hereby undertake to make that information readily available to
you. The Owners shall have the right to impose reasonable conditions such as a
reasonable fee for doing so. In order to ensure that you receive the appropriate
information, you must first give the Owners sufficient details of your objectives and the
other software concerned. Requests for the appropriate information should be made to
the software development manager at The Foundry.

Transfers

If you transfer ownership or otherwise dispose of any property upon which the Software
is copied, you may transfer the Software and all licenses and rights in the Software
granted to you under this agreement to the transferee provided that:

the Owners agree to such a transfer in writing; and

Keylight The Foundry
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such transferee agrees in writing to accept the terms and conditions of this agreement;
and

you contemporaneously transfer all copies of the Software you have made to such
transferee or destroy all copies not transferred; and

any applicable transfer fee is paid to The Owners.

If any transferee does not accept such terms, this agreement shall automatically
terminate and you shall not retain any rights under this agreement in respect of the
transferred Software.

Except as expressly provided in this clause, you may not sublicense, transfer or assign
this agreement or any of your rights or obligations under this agreement, in whole or in
part.

Ownership

You own only the media (or authorised replacement) on which the Software was
recorded. You may retain the media on termination of this agreement provided you have
ensured that the Software contained on or stored in it has been completely erased or
otherwise destroyed.

You acknowledge that the Owners shall at all times retain ownership of the Software as
recorded on the original media and all subsequent copies of it. The Owners transfer no
ownership interest in the Software, in the intellectual property in any Software or in any
copy of it, to you under this agreement or otherwise, and the Owners reserve all rights
not expressly granted to you hereunder.

Termination

If you fail to comply with any of your obligations under this agreement, this agreement,
and all rights and licenses granted hereunder shall automatically terminate without
prejudice to any other rights which the Owners may possess in respect of your default.

The Foundry Keylight

75



76

APPENDIX B

End User License Agreement

Upon termination, you will promptly, and in any event within 30 days of any such
termination, destroy all copies of the Software and its documentation including any
Software stored on any computer under your control.

Disclaimer and Limitation of Liability

The Owners provide the Software to you on an “as is” basis. The express terms of this
agreement are in lieu of all warranties, conditions, undertakings, terms and obligations
implied by statute, common law, trade usage, course of dealing or otherwise (including
without any limitation any warranty of merchantability or fitness for a particular
purpose), all of which are hereby excluded to the fullest extent permitted by law. No oral
or written information or advice given by the Owners employees, representatives, agents
or distributors will create a warranty for the Software and you may not rely on any such
information or advice.

The Owner does not warranty that the Software will meet your requirements or that the
operation of the Software will be uninterrupted or error-free or contain no defects. You
shall load and use the Software at your own risk and in no event will the Owners be
liable to you for any loss or damage of any kind (except personal injury or death
resulting directly from the Owners’ negligence) including lost profits or other indirect or
consequential loss arising from your use or possession of or inability to use the Software
or from errors or deficiencies in it, however arising and whether caused by negligence or
otherwise except as expressly provided herein. In no event shall the Owners’ total
liability arising out of this agreement or your use or possession of the Software exceed
the amount paid by you for the Software.

Law
This agreement shall be governed by and construed in accordance with English Law.
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